
 

SDSU TEMPLATE USER GUIDE 

A template determines the basic structure for a document and contains document 
settings such as fonts, page layout, special formatting, and styles. The default Word 
template is the Normal template, i.e., this is what you are using whenever you create a 
new document in Word. When you open the template, Word will automatically open not 
the template, but a new document based on that template. 

THE SDSU TEMPLATE 

The SDSU Template includes 27 custom styles. To view the styles in Word 2003, go to 
the Formatting tool bar and select the Styles and Formatting button (it looks like two 
A’s). In Word 2007, select the Home tab, go to the Styles group, click on the arrow box 
in the lower right corner, and select “Show Preview” on the bottom of the Styles window.  
 
You must apply these styles to format your text. Only a few styles are invoked 
automatically and they are discussed in the Using Styles section. There are also 
embedded styles for headers, footers, hyperlinks, and page numbers which are not 
shown as they should never be changed. References to “See DTM” means that you 
should refer to the applicable section in the SDSU Dissertation & Thesis Manual. 

Getting Started 

The first time you use the template, you should change the name of the new document 
to something useful for you (but not the same name as your thesis manuscript if you 
already have one started). The name should include your last name (e.g., 
“Jones_Thesis”). By including your name, your manuscript will be easily identified if you 
email it to a professor or the MP reviewer. For the purpose of these instructions, this 
new document will be called “YourTemplate”. Do not cut and paste your manuscript 
into this document. You must follow the instructions below. 
 
As you create your thesis, use the pre-formatted styles as discussed under Using 
Styles. Remember, however, that you must read the SDSU Dissertation and Thesis 
Manual for formatting instructions. There is much more to the formatting requirements 
than can be addressed with the template and this file. 
 
If your thesis is in progress and only contains plain text (i.e., no figures, tables, 
equations, footnotes, or any other special formatting) follow these steps: 
 

Step 1: Open the SDSU Thesis Template that you have downloaded. Scroll to 
the position where you will be putting in existing text (starting with the “Chapter 1” 
page, for example) and click the mouse to position the cursor there. 



 

 
Step 2: Open your existing thesis document and “Select All” (Ctrl +A). Copy the 
selection (Ctrl +C). 

 
Step 3: Go back to the thesis template. Use the “Edit” menu to select “Paste 
Special”. If that choice does not appear, click on the down arrow at the bottom of 
the menu first. The Paste Special window will open. Select “Unformatted Text” 
from the list of choices, then click OK. 
 
Step 4: If your thesis is divided into several separate documents, repeat steps 2 
and 3. Then apply styles as discussed in Using Styles, as your text will not 
automatically format itself. 
 

If your thesis contains figures, tables, equations, footnotes or other special formatting, 
follow these steps: 
  

Step 1: Open YourTemplate and change to “Outline View” (from the “View” menu 
on the menu bar; select “Outline”). Word now recognizes the template as a 
Master Document. Don’t panic when the text immediately looks “unformatted.” 
This is a way to “view” the document as an outline and does not actually change 
the formatting. Once you change back to “Page Layout” view, the document will 
look normal again.  Note for Mac users: Once in “Outline View”, click on the icon 
that says “Master Document View” to expand the toolbar so that you have access 
to additional, necessary icons. 
  
Step 2: Insert your existing document (or documents, if you've saved each 
chapter separately) as a subdocument(s) to YourTemplate (Master Document). 
To insert a subdocument in Word, first make sure the file you want to insert is 
closed. In the “Outline” view select the insertion point with your cursor, click the 
Insert Subdocument button (in Word 2007, you will need to click the Show 
Document button first). Select the document you wish to import. Click within the 
text of the subdocument imported and click the Unlink button--this allows you to 
edit the subdocument within the template. If you have several chapters split up, 
you will need to repeat this process several times until all of the subdocuments 
are in the master document. Save your work. 

 
Once you’ve done all this, your document will not automatically reformat itself. You 
must apply styles as discussed next. 



 

Using Styles 

A style is a set of formatting characteristics that can be applied to text in your document 
to quickly change its appearance. (You should use Word’s Help screens to learn about 
using styles if you've never used them before.) When you apply a style, you apply a 
whole group of formats in one mouse click. For example, in your thesis, the “Chapter #” 
line of each new chapter must:  

 start a new page and be positioned 1.5” from the top of that page, 
 be formatted in all capital letters, bolded, and centered, and 
 be followed by 12 points of extra space. 

All of that can be done instantly by applying the style Chapter Label.  
 
Styles must be applied manually; they are not automatic except in specific cases as 
discussed in the instructions below. Also, do not modify any of the template styles 
except to change the font used in your manuscript (see the section on Changing Fonts) 
or to change from 1-1/2 spacing to double spacing (see the section on Line Spacing). If 
you believe the styles are not working correctly compared to the formatting instructions 
contained in the SDSU Dissertation and Thesis Manual, contact the thesis department 
at Montezuma Publishing. Remember, the templates already have most of the required 
formatting done for you; you won’t normally need to reformat the styles in the template. 
 

TEMPLATE PAGES AND STYLES: INSTRUCTIONS FOR USE 

This section provides instructions for using each of the template’s pre-formatted pages 
as well as the text styles.   
General Troubleshooting:  

 All of the styles will "kick in" once you start typing something, not necessarily 
when you select the style (unless you are selecting existing text and applying a 
new style to it). So ignore the fact that your cursor may still appear to be on the 
previous line, for example, even though you've hit the enter key. Start typing 
before you get concerned. 

 If the last page of the reference list looks centered (assuming that the text on 
those pages do not fill the page), and the header area looks really large—you 
have inadvertently deleted the “Section Break-Next Page” marker at the bottom 
of the Reference Page in the template. Therefore, your text has picked up the 
“Center Vertical” command from the Appendix Cover Page that follows the 
References Page in the template. To correct this, go to the bottom of the last 
page in your Reference section and reinsert the section break (click on 
INSERT/Break/Section Break: Next Page). Then insert your cursor anywhere in 
the reference section, click on FILE, Page Setup, the Layout tab, and under 
Vertical Alignment, select “Top” (it will be showing “Center”). 



 

 How do I format a page for Landscape orientation? There are two preformatted 
landscape pages in the template. See instructions under the Landscape Pages 
section regarding how to use them. 

PAGINATION 

Note that the page number format can be handled with the “Insert” menu as well as with 
the header/footer toolbar using these steps:  

Step 1: Select Insert/Page Number and make sure that the position is “top of 
page” and alignment is “right” (for pages in portrait orientation).  
Step 2: Then click on the “Format” button. Make sure that the “number format” is 
correct for the section you are in (1, 2, 3 for all but the preliminary pages).  
Step 3: Under “Page numbering” select “continue from previous section” or “start 
at” depending on what you need. When you select “start at” the default is page 1. 
If you need a different page number, just type it in.  

 If you are changing the style as well (e.g. from Roman to Arabic), you will 
need to first go into the header area (View/Headers and Footers) and 
toggle off the “Link to Previous” icon. To do this, find the “Link to Previous” 
icon (in the Header and Footer toolbar--it will look “selected”) and click on 
it. This will turn the function off (i.e., remove the link to the previous 
section so that the change you are about to make won’t affect the previous 
section). 

 
Starting with the Copyright Page (p. iii), all pages must show page numbers at the top 
right corner (see the DTM for specifics). Pagination has already been set up in the 
template so you should see the page number (iii) at the top of the Copyright Page. 
Pagination for the text starts over again at “1” in Arabic numerals, and this also has 
been set up in the template.  
 
However, if you accidentally delete the section break at the end of the 
ACKNOWLEDGEMENTS page, the page numbering may NOT be correct (i.e., text 
page numbering will continue from the previous section). If this happens, Chapter 1 may 
start on p 11 for example. Or, if you copied and pasted the landscape pages (with their 
section breaks as directed), the section following the landscape pages may not be 
numbered correctly. If this happens, reset the page numbering as follows: 

 If Chapter 1 does not start at 1: 
o Double click in the grayed header area. Click on the “Format page 

number” icon. Under “page numbering” click the round button that says 
“Start At” – it will automatically insert the page number “1”. Then click OK 
to exit.  



 

 If this doesn’t work (or another area other than the first text page is involved, 
check the following areas and try these methods: 

o With your cursor on the affected page, double click in the grayed header 
area. If, at the top right of the header area, you see the words, “same as 
previous,” remove the link to the previous section (so you can do 
something different in the current section). To do this, find the “Link to 
Previous” icon (in the Header and Footer toolbar--it will look “selected”) 
and click on it. This will turn the function off 

o Click on the “Insert page number” icon. 
o Click on the “Format page number” icon. Under “number format” select “1, 

2, 3” and under “page numbering” click the round button that says “Start 
At” – it will automatically insert the page number “1”. If that is the page 
number you want, click OK to exit. If not, type in the correct page number 
and click OK. 

o Re-check your page numbering. Your acknowledgements page should 
show the correct number in lowercase Roman numerals and your first text 
page should show “1”. Then make sure page numbering throughout the 
text is continuous, even on the landscape pages. 

Landscape Pages 

There are 2 landscape pages in the separate “SDSU Template Landscape Pages” file—
one with normal margins and one with minimal margins—both followed by a properly 
formatted portrait page and with page numbers in their correct positions. To place a 
landscape page or pages in your manuscript: 

1. Download/Save and then open the “SDSU_Template_Landscape.dot” file. 
2. Go to the page prior to the landscape page that you want and place your cursor 

before the section break. [You should be working with the show/hide feature 
turned on so that you can see it. The icon on your toolbar for this looks like a 
paragraph mark (¶)]. 

3. Scroll down through the landscape page and position your cursor after the first 
word on the following portrait page. Press Shift and click. That will select that 
entire portion.  

4. Press Ctrl+C to copy those pages, then place your cursor at the end of the page 
prior to where you want to place your landscape page(s) and press Ctrl+V to 
paste them in. At this point, you can delete the word from the page following the 
landscape page (and section break if you also picked that up in error) so that you 
now continue on that page with your own text. 

5. To insert more landscape pages elsewhere in your document, repeat steps 1-4. 
Check page numbering. If the page numbers on the landscape pages are not in 
the correct position, see Troubleshooting #2 below. 



 

TROUBLESHOOTING 

1. The page numbers are at the bottom of pages that follow the landscape pages. 
The numbers may be at the bottom of the page or both at the top (correctly) and 
the bottom. This shouldn’t occur if you are following precisely the directions 
above. The solution involves the “Link to Previous” button on the Header/Footer 
toolbar. 

a. With your cursor on the portrait page following the landscape page, double 
click in the grayed footer area. If, at the top right of the footer area, you 
see the words, “same as previous,” remove the link to the previous 
section. To do this, find the “Link to Previous” icon (in the Header and 
Footer toolbar, 5th from the right--it will look “selected”) and click on it.  

b. Select the page number and delete it. 
c. If the page number is missing in the header: 

i. Click in the header area and remove the link to the previous section 
(because the page number was deleted from the header area on 
the landscape page). 

ii. Select the “Format Page Number” icon in the header toolbar (3rd 
from the left), and click the button that says “continue from previous 
section.” 

2. How do I get the page number in the correct position on “landscape” pages? The 
best way is to use one of the 2 preformatted landscape pages in the template. 
There is one for use with “normal margins” and one set up with “minimal 
margins.” On these pages, the Page Setup has been altered for margin and 
header/footer settings as well as the page number format. Make sure you retain 
the “Section Break-Next Page” markers preceding and following each page.  

a. Click on the template landscape page and look at Page Setup. Set the 
same margin and header/footer settings you see there in your document.  

b. In the Header/Footer view, make sure you de-select the “same as 
previous” icon in the header for the landscape page and for the portrait 
text page that follows. For the portrait page that follows, do the same for 
the footer.  

c. Select Insert/Page Number and set it for placement at the bottom right. 
Click on the Format button and make sure page numbering is set at 
“continue from previous section.” If the page number is still not correct– 
see the Pagination section of this document. 

d. Go back into the footer area and select the page number inside the text 
box (but not the text box itself) and rotate the number (Format/Text 
Direction).  



 

FONTS 

Although the template uses Times New Roman 12 pt. font, you may change to a 
different font style if you prefer (but, first, read Sections 4.1.1 & 4.1.2 in the DTM).  

1. To change the template font with another font that prints at approximately the 
same size (CG Times, e.g.), you only need to change the font in the Normal style 
as all of the styles are based on that one style. From the Styles & Formatting 
Task Pane: 

a. Move your mouse over the Normal Style and click on the down arrow that 
appears.  

b. Select “Modify,” Select “Format,” then Select “Font.”  
c. From the “Font” Window, select the font you want.  
d. Click OK twice to exit the menus. 

2. To change the font with another that prints at a larger size (e.g., Arial 12 pt. is 
significantly larger than Times New Roman 12 pt), follow steps 1a – c above, 
then: 

a. While still in the “Font” Window, change the font “size” appropriately (e.g., 
either Arial 10 pt or 11pt is acceptable) 

b. Click OK twice to exit the menus. 
c. Move your mouse over the Chapter Label style. Again select “Modify,” 

“Format,” and “Font.” 
d. Change the font size to 2 pts larger than you set for the NORMAL style. If 

that font size is not shown in the scrollable list (e.g. 13), just type it in 
manually. 

e. Click OK twice to exit the menus. 
f. Follow steps 2c-e once more for the Heading 1 style. 
g. Follow step 2c for the Footnote Text style and change the font size to 2 

pts smaller than you set for the Normal style. 

LINE SPACING 

The template is set up for 1.5 spacing, but you may use double-spacing if desired. To 
do so, you will need to modify eight of the template styles and the preliminary page lists 
as follows: 

1. Open the “Styles & Formatting” task pane (Format menu/Styles & Formatting) 
and hold your cursor over the desired style. A drop-down arrow will appear to the 
right of the style name. Click on the down arrow and select “Modify.” 

2. The “Modify Style” window will open. Click on the “Format” button at the bottom 
of the window, then “Paragraph”. [Note: If your thesis already exists and you’ve 
already applied styles to your text, once you’ve modified the styles as indicated 
below, and before clicking OK to exit the “Modify Style” window, click on the 
“Automatically Update” button in the bottom right corner.  



 

3. Modify styles as follows: 
a. Normal – Set line spacing at double (vs. 1.5 spacing).  
b. Heading 1 – Set space after at 12 points (vs 6); line spacing stays at 

single. 
c. Block Quotation – Same as Heading 1. 
d. Hanging Indent or Hanging Indent Author/Number – Same as Heading 1. 
e. List Bullet or List Number – Same as Heading 1. 
f. Caption – (For figure captions), Set space after at 24 points (vs 18). 
g. TOC 1 – (For Table of contents), Same as Heading 1. 
h. Table of Figures – (For Lists of Tables & Figures), Same as Heading 1. 

4. Modify the Table of Contents, List of Tables, and List of Figures (after you 
generate them as follows:  

a. Table of Contents: Select the word Page through the word Chapter (the 
area that is not automatically updated) and change those lines to double 
spacing.  

b. Lists of Tables & Figures: Click on the word Page and change that line to 
double spacing. 

FIGURES AND TABLES 

Spacing Before and After Figures and Tables 

Figures and Tables require special 12pt. spacing before and after their appearance in 
the text. There are a couple of ways to do this: 

1. You may click the Figure or Table; select “Paragraph”; see the “Indents and 
Spacing” tab; under the “Spacing” section, set the “Before” and “After” sections to 
12pt. 

2. You may select the paragraph that precedes the Figure or Table and select 
“Paragraph”; see the “Indents and Spacing” tab; under the “Spacing” section, set 
the “After” section to 12pt for the paragraph preceding the Figure or Table. Then 
select the paragraph that follows the Figure or Table and select “Paragraph”; see 
the “Indents and Spacing” tab; under the “Spacing” section, set the “Before” 
section to 12pt for the paragraph preceding the Figure or Table. 

Captions and Titles 

Read Section 4.10 in the DTM for complete instructions regarding tables and figures, 
including the required spacing to separate them from text and how to format tables that 
run to another page. 
 
After inserting or creating a figure, you need to create a Figure Caption. Place your 
cursor on the line directly under the figure and select the style called Caption. Type the 



 

Figure number followed by a period and a space. Type the caption capitalized in 
sentence style. The style automatically adds the necessary extra space to separate it 
from the following text. Do not place your caption in a text box. Although a good way to 
keep the figure & caption together, it prevents the automatic generation of the List of 
Figures. 
 
After creating a table, you will need to create a table title. Place your cursor on the line 
above the table and select the style called Table Title. Type the Table number followed 
by a period and a space. Type the title capitalized in headline style. The style 
automatically adds the necessary extra space to separate it from the preceding text and 
the table itself. 

Cropping 

There may be situations in which you paste in a Figure or Table image into your 
document and there is a large amount of white space surrounding it that causes the 
spacing to be inconsistent. Follow these instructions to correct this issue: 

 For Word 2003, right click on the graphic and select “Show Picture Toolbar.” 
Select the Crop tool, place it on the middle square along each side of the 
graphic, and drag it up, down, right, or left to remove unwanted white space.  

 In Word 2007, select the image, select “Layout” under the “Picture Tools” menu, 
Select the Crop tool, place it on the middle square along each side of the 
graphic, and drag it up, down, right, or left to remove unwanted white space. 

Aligning Text with Image 

You can use your ruler to set temporary left and right margins. For example, usually 
table titles and figure captions in your thesis should be aligned with the left and right 
margins of the graphic itself (rather than the left & right margins of the page); see the 
DTM for exceptions. 
 
If you don’t have a horizontal ruler showing at the top of your document, bring up the 
ruler by clicking on View on your Menu Bar and selecting Ruler. 
 
To align the text to the graphic, click on the table title or figure caption that needs 
alignment. 

 Move your pointer to the ruler. Click on the rectangular portion of the left margin 

marker    and you will see a dotted vertical line through your page. Drag the 
margin marker to the left edge of the graphic (where the dotted line meets the 
graphic). For “fine tuning,” hold down the Alt key while you drag. Release the 
mouse click. Note that figure captions must be aligned with the visible (when 



 

printed) edge of the graphic, not the non-printing border displayed on screen 
when the graphic is selected. 

 Then click on the right margin  marker and drag it to the right side of the 
graphic. 

 

EQUATIONS: 
ALIGNMENT OF EQUATIONS AND EQUATION NUMBERS 

To center equations on the page, but at the same time, right align the equation 
numbers, you need to set tabs by following these steps: 

1. If you don’t see a horizontal ruler at the top of your page, bring it up by selecting 
View/Ruler. 

2. Click the icon on the far left of the ruler until you get the type of tab you need, 
then click the ruler where you want the tab to appear. Set a center tab () at the 

3.13” position (1st dot after the 3) and a right-aligned tab (  |) at the 6.25” 

position, i.e., on top of the right margin marker. To do the latter, click on your 
ruler to the left of the right margin marker to deposit the tab on the ruler, then 
click and drag it on top of the right margin marker. (MAC users can place the tab 
directly on top of the right margin marker.) 

3. Make sure the line for the equation is set for left alignment (just like your text), 
then press the tab key once before the equation (which will center the equation), 
and once after (which will place the equation number at the right margin). 

4. If you are reformatting this line (i.e., it already existed but was not formatted 
properly), make sure you delete any extra spaces or other incorrect formatting 
that may be there. Work with the Show/Hide button on your toolbar turned on 
(looks like the paragraph symbol, ¶) so that you can see spaces, tabs, paragraph 
markers, etc. 

REFERENCES 

Footnotes 

When inserting footnotes, the Footnote Base and Footnote Text styles will be invoked. 
Extra space will be left between each note automatically.  Only use footnotes for source 
documentation if consistent with your department style guide. 

Reference List 

There are 2 possible styles to use on this page: Hanging Indent, and Hanging Indent 
Author/Number. The difference is in the tab settings. Delete the instructions on that 
page before adding your reference list, but do not delete the Section Break on that 



 

page (click the Show/Hide icon on the Standard Toolbar to see the section break). Then 
follow the instructions below. 

1. Reference Manager and Endnote programs will both work with the template. 
However, when you generate the reference list, those programs will put the list at 
the very end of the manuscript. If you have appendices—which must come after 
the reference list—move the appendices behind the generated reference list. If 
you try to move the reference list in front of the appendices, you will break all the 
reference links created by those programs. Then just make sure that the page 
layout conforms to the SDSU style. 

2. When using an “author/year” (e.g., APA) or “author/page” (e.g., MLA) style where 
the list is alphabetized by authors’ last names, you will be using the Hanging 
Indent style. Select that style then follow the instructions in #5 to input your 
entries. If your entries already exist, select the entire list then apply the Hanging 
Indent style. 

3. When using an “author/number” system you need to use the Hanging Indent 
Author/Number style. Select that style, and then press the TAB key once. Type 
your number and a period or [#], or (#), and press TAB again, then start your 
entry following the instructions in #5. If your entries already exist, select the entire 
list then apply the HANGING INDENT AUTHOR/NUMBER style. 

4. Anthropology students using AAA, or any others using an inverted stair-step 
formation for the reference list, will need to set appropriate tabs and the hanging 
indent position themselves.  

5. When typing your entries: Press the ENTER key only at the end of each entry 
(NOT at the end of each line). The second and subsequent lines of an entry will 
automatically wrap to the ½” indent level. Also, Do NOT press ENTER in 
between entries; the style automatically adds 6 points after each paragraph to 
separate them. 

TROUBLESHOOTING 

1. You select your reference list text and apply the Hanging Indent style, but nothing 
changes. You did not originally type your list according to #5 above. Clean it up 
as follows:  

a. (1) Delete extra paragraph markers between entries and at the end of 
each line; then delete any tabs or spaces used to “indent” subsequent 
lines. If you are using the author/number style and you spaced after the 
number to the text, you will also need to delete those spaces and replace 
them with a Tab as instructed in #3 above. Also, make sure you press the 
Tab key in front of the number, i.e., to start the line. You may not see a 
change immediately, but you will when you press the Tab key after the 
number. 



 

b. (2) Select all the entries (but not the section title) and apply 1 of the 2 
Hanging Indent styles as appropriate.  

2. You select your reference list text and apply the Hanging Indent Number/Author 
style, but the list is not automatically numbered. This is correct—this is not 
something the template does for you. Follow step #1 above. 

APPENDICES 

For appendix cover sheets, select the style called Appendix Label for the identifier line 
and Appendix Title for the appendix title line. There is one page set up for this in the 
template. It is coded to center the text vertically on the page. Be careful not to delete the 
Section Breaks preceding and following this page. If you also want to title the first page 
of the appendix with the appendix title, use the style Prelim Title so that this title does 
not get pulled into the Table of Contents (or it will appear twice in the Table of 
Contents). 
 
If you have more than one appendix, you will need to copy and paste the cover sheet as 
many times as you need it, but follow these instructions in doing so. 

1. Place your cursor to the left of the section break at the bottom of the References 
page and left click. 

2. Scroll down to the page following the cover page, place your cursor after the first 
word on that page (“Insert”), hold down the Shift key and left click again. This will 
select everything between and including the section breaks before and after the 
appendix cover page. 

3. Copy the selected text, then, paste it in as many times as necessary to cover the 
number of appendices you have. 

4. All of the appendix content pages (after the 1st one that has all the instructions) 
will have the word “insert” on it; just replace that text with your appendix material.  

5. Check pagination. Sometimes the appendix sections (or prior sections) will 
restart page numbering with “1.” Follow the instructions under the section for 
Pagination to fix that. 

TROUBLESHOOTING 

1. You apply a style and nothing happens. All of the styles are paragraph styles, 
and they will kick in once you start typing something, not necessarily when you 
select the style (unless you are selecting existing text and applying a new style to 
it). So ignore the fact that your cursor may still appear to be on the previous line, 
for example, even though you've hit the enter key. Just start typing and you 
should immediately see it “kick in.” 

2. The page numbers are at the bottom of pages that follow the landscape pages. 
See the section on Landscape Pages. 



 

3. How do I get the page number in the correct position on “landscape” pages? See 
the section on Landscape Pages. 

LIBRARY ABSTRACT PAGE 

The Library Abstract page is turned in with your manuscript but will not stay with it. 
Instead, it will be removed from your manuscript and sent separately to the library for 
uploading to the electronic catalog system (PAC). See Section 4.6.6.2 in the DTM.  
 
This page is exactly the same as the abstract you have in the preliminary pages of the 
manuscript except for:  

(a) the formatting of the title “Abstract of the Thesis”—which should be in 12pt. 
font (or same font size as text) and not bolded,  
(b) left and top margins—should be 1 inch, and  
(c) omission of page numbering. The last page in the template has been set up 
for you with this configuration.  

This abstract page also has form fields where you need to input information. After that, 
all you need to do is copy the abstract text from the abstract page in your preliminary 
pages and paste it to the library abstract page.  
 
If you have any questions, call 619.594.7551 or email 
thesis@montezumapublishing.com. 
 


